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Engineering Analysis with SOLIDWORKS Simulation 2019

2: Static analysis of a plate

Topics covered

a

a
a
a
a

Using the SOLIDWORKS Simulation interface

Linear static analysis with solid elements

Controlling discretization error with the convergence process
Finding reaction forces

Presenting FEA results in a desired format

Project description

Fixed restraint

A steel plate is supported and loaded, as shown in Figure 2-1. We assume that
the support is rigid (this is also called built-in support, fixed support or fixed
restraint) and that a 100000N tensile load is uniformly distributed along the end
face, opposite to the supported face.

100000N force
uniformly distributed
normal to face

Figure 2-1: SOLIDWORKS model of a rectangular plate with a hole.

We will perform a displacement and stress analysis using meshes with different
element sizes. Notice that repetitive analysis with different meshes does not
represent standard practice in FEA. However, repetitive analysis with different
meshes produces results which are useful in gaining more insight into how FEA
works.
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Procedure

In SOLIDWORKS, open the model file called HOLLOW PLATE. Verify that
SOLIDWORKS Simulation is selected in the Add-Ins list (Figure 2-2).

Add-Ins

Active Add-ins

Start Up

Last Load
Time

[—|SOLIDWORKS Premium Add-ins

[ Circuitworks

188 Featureworks

1@ Photoview 360

1%, ScanTo3D

[71@L. SOLIDWORKS Design Checker
142 SOLIDWORKS Motion

[T SOLIDWORKS Routing

@ SOLIDWORKS Simulation
1'F SOLIDWORKS Toolbox Library
| SOLIDWORKS Toolbox Utilities
19§ soupworks utilities
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[+|SOLIDWORKS Add-ins

OO0 O0ONOOOOOOO

Select

25 SOLIDWORKS
Simulation as Active
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[+]Other Add-ins
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| [ cancel

Figure 2-2: Add-Ins list in SOLIDWORKS.

Verify that SOLIDWORKS Simulation is selected in the list of Add-ins.

Once Simulation has been added, it shows in the main SOLIDWORKS menu
and in the Command Manager.
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Simulation Pin down
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» @] Boss-Extrudel
» (@ Cut-Extrudel

Figure 2-3: The Simulation tab is a part of the SOLIDWORKS Command
Manager.

Selecting the Simulation tab in the Command Manager displays Simulation menu
items (icons). Since no study has yet been created, only the Study creation icon is
available; all others are grayed-out. For convenience, pin down the top tool bar
as shown. Command Manager with Large Buttons is shown in this illustration.

Notice that Feature Manager Design Tree shown in Figure 2-3 displays Solid
Bodies and Surface Bodies folders. These folders can be displayed by right-
clicking anywhere in Feature Manager Design Tree to bring up the pop-up
menu and selecting Hide/Show Tree Items. This will invoke System Options-
Feature Manager (not shown here). From there, Solid Bodies and Surface
Bodies folder can be selected to show (Figure 2-3). We will need to distinguish
between these two different bodies in later exercises. In this exercise these two
folders do not need to show.
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Before we create a study, let’s review the Simulation main menu (Figure 2-4)
along with its Options window (Figure 2-5).

1775 SOLIDWORKS File Edit View Insert Tools Simulation | Window Help & ) [°

q Cf Study... — New Study
Study Material »
= Loads/Fixture »

Features | Sketch | Evaluate | DimXpert | SOLIDWORKS

Contact/Gaps |

: = >
G ER[¢ (6] i :
\Td
@ HOLLOW PLATE (Default<<Default> Topology Study ;
> History Mesh ’

Sensors
» Annotations
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Surface Bodies
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[ Front Plot Results y
[ Top List Results »
[J Right Result Tools ’
{_. Origin

4 @ Boss-Extrudel

» (@ Cut-Extrudel }

Fatigue »

Import Motion Loads...

&} Options.. Simulation
Help . Options

About Simulation

Figure 2-4: Simulation main menu.

Similar to the Simulation Command Manager shown in Figure 2-3, only the New
Study icon is available. Notice that some commands are available both in the
Command Manager and in the Simulation menu.

Simulation studies can be executed entirely from the Simulation drop down
menu shown in Figure 2-4. In this book we will use the Simulation main menu
and/or Command Manager to create a new Study. Everything else will be done
in the Study Property Manager window.
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Now click on the Simulation options shown in Figure 2-4 to open the
Simulation System Options window shown in Figure 2-5.

Default Options

Default Options - Units &

_m Default Options |

Load/Fixture Unit system
Mesh Q) sI (MKS)
Results English (IPS)
= Plot Metric (G)
Color Chart
= Default Plots Units
i i g o+ —
= ¥ static Study Results Length/Displacement: [ =
& Piot1 ‘—Ji
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-a¥ Frequency/Buckling Study Results i " W
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= &P Drop Test Study Results
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£1d® Fatigue Study Results
| L®pion
B rior2
Jr 'E.?Opu‘mization Study Results
=€ Nonlinear Study Results
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User information
Report
Simulation sensors

[ ok } [ cancel ] [ Help.:

Figure 2-5: Simulation Options window.

The Options window has two tabs. In this example, Default Options and Units
are selected and shown.

Please spend time reviewing all of the options in both System Options and
Default Options shown in Figure 2-5 before proceeding with the exercise. In the
Units options, make the choices shown in Figure 2-5. In this book we will
mostly use the SI system of units using MPa rather than Pa as a unit of stress and
pressure. Occasionally we will switch to the IPS system.

Notice that Default Plots can be added, modified, deleted or grouped into sub-
folders which are created by right-clicking on the results folders, for example,
Static Study Results folder, Thermal Study Results folder, etc.
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Creation of an FEA model starts with the definition of a study. To define a new
study, select New Study in either the Simulation tab in the Command Manager
(Figure 2.3) or Simulation main menu (Figure 2-4). This will open the Study
Property Manager. Notice that the New Study icon in the Simulation
Command Manager can also be used to open the Study Advisor. We won't be
using the Study Advisor in this book. Name the study tensile load 01 (Figure 2-

6).
177550LIDWORKS File Edit View Insert Tools Simulation Window Help &
«
Study
New Study button in the . -
Simulation tab can 1@ Newswd ) ] :
also be used to open - | Yy Xpert | SOLIDWORKS Add-Ins | Simulation | Analysi:
8’" Simulation Advisor

the Simulation Advisor

Study @ @
v X -
Message v
Name ~
Enter study name —— tensile load 01
General Simulation A

. + o
Select Static —— Static

Use 2D Simplification

al| Frequency - Study Prop§rty
Manager window
Design Insight v :|
Advanced Simulation v
Specialized Simulation N

Figure 2-6: Creating a new study.

The study definition window offers choices of the type of study, here we select
Static. Static study and Frequency study belong to the group called General
Simulation.
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Engineering Analysis with SOLIDWORKS Simulation 2019

Once a new study has been created, Simulation Commands can be invoked in
three ways:

O From the Simulation Command Manager (Figure 2-4)

O From the Simulation main menu (Figure 2-4)

O By right-clicking appropriate items in the Study Property Manager
window. In this book, we will most often use this method.

When a study is defined, Simulation creates a study window located below the
Feature Manager Design Tree and places several folders in it. It also adds a
study tab located next to Model and Motion Study tabs. The tab provides access
to the study (Figure 2-7). We won't be using the Motion Studies in this book.
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Figure 2-7: The Simulation window and Simulation tab.

You can switch between the SOLIDWORKS Model, Motion Studies and
Simulation Studies by selecting the appropriate tab.
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We are now ready to define the analysis model. This process generally consists
of the following steps:

0 CAD geometry idealization and/or simplification in preparation for analysis.
This is usually done in SOLIDWORKS by creating an analysis specific
configuration and making your changes there

0 Material properties assignment

O Restraints definition

0 Loads definition

In this case, the geometry does not need any preparation because it is already
very simple; we can start by assigning material properties.

Notice that if a material is defined for a SOLIDWORKS part model, the
material definition is automatically transferred to the Simulation model.
Assigning a material to the SOLIDWORKS model is actually a preferred
modeling technique, especially when working with assemblies consisting of parts
with different materials. We will do this in later exercises.

To apply material to the Simulation model, right-click the HOLLOW PLATE
folder in the tensile load 01 simulation study and select Apply/Edit Material
from the pop-up menu (Figure 2-8).
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Figure 2-8: Assigning material properties.

The top window shows the first step in the process of applying material

properties to the mode

L.

The bottom window shows modification to System Options, this needs to be done

only once.
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The action in Figure 2-8 opens the Material window shown in Figure 2-9.
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4 1 3
Click here to access more materials using [ = ] [ R ] I — l I = } [ = ]
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Figure 2-9: Material window.

Select Alloy Steel to be assigned to the model; select MPa as units.
Click Apply, and then click Close.
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In the Material window, the properties are highlighted to indicate the mandatory
and optional properties. A red color description (Elastic modulus, Poisson’s
ratio) indicates a property that is mandatory based on the active study type and
the material model. A blue color description (Mass density, Tensile strength,
Compressive strength, Yield strength, Thermal expansion coefficient) indicates
optional properties. A black color description (Thermal conductivity, Specific
heat, Material damping ratio) indicates properties not applicable to the current
study.

In the Material window, open the SOLIDWORKS Materials menu, followed
by the Steel menu. Select Alloy Steel. Select SI units under the Properties tab
(other units could be used as well). Notice that the HOLLOW PLATE folder in
the tensile load 01 study now shows a check mark and the name of the selected
material to indicate that a material has been assigned. If needed, you can define
your own material by selecting Custom Defined material.

Material definition consists of two steps:

O Material selection (or material definition if a custom material is used)

O Material assignment (either to all solids in the model, selected bodies of a
multi-body part, or to selected components of an assembly)

Having assigned the material, we now move to defining the restraints. To display
the pop-up menu that lists the options available for defining restraints, right-click
the Fixtures folder in the tensile load 01 study (Figure 2-10).
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Type tab ~ Split tab

Fixture @
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; Advanced N
Hide All
Show All Symbol Settings v
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Figure 2-10: Pop-up menu for the Fixtures folder and Fixture definition window
(Fixture Property Manager).

All restraints’ definitions are done in the Type tab. The Split tab is used to define
a split face where restraints are applied. The same can be done in
SOLIDWORKS by defining a Split Face.
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Once the Fixtures definition window is open, select the Fixed Geometry
restraint type. Select the end-face entity where the restraint is to be applied.
Click the green check mark in the Fixture Property manager window to complete
the restraint definition.

Notice that in SOLIDWORKS Simulation, the term “Fixture” implies that the
model is firmly “fixed” to the ground. However, aside from Fixed Geometry,
which we have just used, all other types of fixtures restrain the model in certain
directions while allowing movements in other directions. Therefore, the term
“restraint” may better describe what happens when choices in the Fixture
window are made. In this book we will switch between the terms “fixture” and
“restraint” freely.

The existence of restraints is indicated by symbols shown in Figure 2-10. In the
Symbol Settings of the Fixture window, the size of the symbol can be changed.
Notice that symbols shown in Figure 2-10 are distributed over the highlighted
face meaning the entire face has been restrained. Each symbol consists of three
orthogonal arrows symbolizing directions where translations have been
restrained. Each arrow has a disk symbolizing that rotations have also been
restrained. The symbol implies that all six degrees of freedom (three translations
and three rotations) have been restrained. However, the element type we will use
to mesh this model (second order solid tetrahedral element) has only translational
degrees of freedom. Rotational degrees of freedom can't be restrained because
they don't exist in this type of element. Therefore, disks symbolizing restrained
rotations are irrelevant in our model. Please see the following table for more
explanations.

Before proceeding, explore other types of restraints accessible through the
Fixture window. Restraints can be divided into two groups: Standard and
Advanced. Review animated examples available in the Fixture window and
review the following table. Some less frequently used types of restraints are not
listed here.
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Standard Fixtures

Fixed Also called built-in or rigid support. All translational and all
rotational degrees of freedom are restrained.
Only translational degrees of freedom are restrained, while
Immovable rotational degrees of freedom remain unrestrained.

(No translations)

If solid elements are used (like in this exercise), Fixed and
Immovable restraints would have the same effect because
solid elements do not have rotational degrees of freedom.
Therefore, the Immovable restraint is not available if solid
elements are used alone.

Roller/Slider

Specifies that a planar face can move freely on its plane but
not in the direction normal to its plane. The face can shrink or
expand under loading.

Fixed Hinge

Applies only to cylindrical faces and specifies that the
cylindrical face can only rotate about its own axis. This
condition is identical to selecting the On cylindrical face
restraint type and setting the radial and axial components to
ZEero.

Advanced Fixtures

Symmetry

Applies symmetry boundary conditions to a flat face.
Translation in the direction normal to the face is restrained
and rotations about the axes aligned with the face are
restrained.

Cyclic symmetry

Allows analysis of a model with cyclic patterns around an
axis by modeling a representative segment. The geometry,
restraints, and loading conditions must be identical for all
other segments making up the model. Turbine, fans,
flywheels, and motor rotors can usually be analyzed using
cyclic symmetry.

Use Reference

Restrains a face, edge, or vertex only in certain directions,
while leaving the other directions free to move. You can

Geometry specify the desired directions of restraint in relation to the
selected reference plane or reference axis.
Provides restraints in selected directions, which are defined
On Flat Faces by the three directions of the flat face where restraints are

being applied.

On Cylindrical
Faces

This option is similar to On flat face, except that the three
directions of a cylindrical face define the directions
of restraints.

On Spherical Face

Similar to On Flat Faces and On Cylindrical Faces. The
three directions of a spherical face define the directions
of the applied restraints.
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When a model is fully supported (as it is in our case), we say that the model does
not have any rigid body motions (the term “rigid body modes” is also used),
meaning it cannot move without experiencing deformation.

Notice that the presence of restraints in the model is manifested by both the
restraint symbols (showing on the restrained face) and by the automatically
created icon, Fixture-1, in the Fixtures folder. The display of the restraint
symbols can be turned on and off by either:

O Right-clicking the Fixtures folder and selecting Hide All or Show All in
the pop-up menu shown in Figure 2-10, or

O Right-clicking the fixture icon and selecting Hide or Show from the
pop-up menu.

Use the same method to control display of other Simulation symbols.
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Now define the load by right-clicking the External Loads folder and selecting
Force from the pop-up menu. This action opens the Force window as shown in
Figure 2-11.
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@ HOLLOW PLATE (-Alloy Steel-)
g1 Connections
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v X ™
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Force/Torque @ Mesh 18 External Loads Advisor... E 9
Force —— For
Property Manager Result Opti¢ § Force.. ‘ oree

.

% Torque... L‘%l e

L .

ress-gre © This window

o Gravity.. shows geometric

&3 Centrifugal... entities where

¥ Bearing Load... . loads are applied

4 Temperature... @ Normal

Bi Prescribed Displacement... () Selected direction

¥ Flow Effects... B [SI b

Thermal Effects... 4 100000 YN

e [¥] Reverse direction
> Remote Load/Mass...

@) Per item
£ Distributed Mass.. -
5 Create New Folder [ Nonuniform Distribution v
Hide All Symbol Settings ~
O Copy Al 200 — Symbol size set

to 200

[V] show preview

Force Value (N): |100000 |

Figure 2-11: Pop-up menu for the External Loads folder and Force window.

The Force window displays the selected face where the tensile force is applied. If
only one entity is selected, there is no distinction between Per Item and Total. In
this illustration, load symbols have been enlarged by adjusting the Symbols
Settings. Symbols of previously defined restraints have been hidden.
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In the Type tab, select Normal in order to load the model with a 100000N
tensile force uniformly distributed over the end face, as shown in Figure 2-11.
Check the Reverse direction option to apply a tensile load.

Generally, forces can be applied to faces, edges, and vertices using different
methods, which are reviewed below:

Force normal Available for flat faces only, this option applies load in
the direction normal to the selected face.

Force selected direction | This option applies a force or a moment to a face,
edge, or vertex in the direction defined by the selected
reference geometry.

Moments can be applied only if shell elements are used.
Shell elements have six degrees of freedom per node:
three translations and three rotations, and can take a
moment load.

Solid elements only have three degrees of freedom
(translations) per node and, therefore, cannot take a
moment load directly.

If you need to apply moments to solid elements, they
must be represented with appropriately applied forces.

Torque This option applies torque (expressed by traction
forces) about a reference axis using the right-hand rule.

Try using the click-inside technique to rename the Fixture-1 and Force/Torque-
1 items. Notice that renaming using the click-inside technique works on all items
in SOLIDWORKS Simulation.

The model is now ready for meshing. Before creating a mesh, let’s make a few
observations about defining the geometry, material properties, loads and
restraints.

Geometry preparation is a well-defined step with few uncertainties. Geometry
that is simplified for analysis can be compared with the original CAD model.

Material properties are most often selected from the material library and do not
account for local defects, surface conditions, etc. Therefore, the definition of
material properties usually has more uncertainties than geometry preparation.

The definition of loads is done in a few menu selections but involves many
assumptions. Factors such as load magnitude and distribution are often only
approximately known and must be assumed. Therefore, significant idealization
errors can be made when defining loads.
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Defining restraints is where severe errors are most often made. For example, it is
easy enough to apply a fixed restraint without giving too much thought to the
fact that a fixed restraint means a rigid support — a mathematical abstraction. A
common error is over-constraining the model, which results in an overly stiff
structure that underestimates displacements and stresses. The relative level of
uncertainties in defining geometry, material, loads, and restraints is qualitatively
shown in Figure 2-12.

Geometry Material Loads Restraints

Figure 2-12: Qualitative comparison of uncertainty in defining geometry,
material properties, loads, and restraints.

The level of uncertainty (or the risk of error) has no relation to time required for
each step, so the message in Figure 2-12 may be counterintuitive. In fact,
preparing CAD geometry for FEA may take hours, while defining material
properties and applying restraints and loads takes only a few clicks.
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In all of the examples presented in this book, we assume that definitions of
material properties, loads, and restraints represent an acceptable idealization of
real conditions. However, we need to point out that it is the responsibility of the
FEA user to determine if all those idealized assumptions made during the
creation of the mathematical model are indeed acceptable.

Before meshing the model, we need to verify under the Default Options tab, in
the Mesh properties, that High mesh quality is selected (Figure 2-13). The
Options window can be opened from the SOLIDWORKS Simulation menu as

shown in Figure 2-4.

Mesh quality: High

Default Options
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Default Options - Mesh

| System Options | Default Options |

Units
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Results
=-Plot
‘ Color Chart
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=@ Drop Test Study Results
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& Piot2
% riot3
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Pt
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89 Optimization Study Results
=@ Nonlinear Study Results
% riot1
& piot2
& piot3
User information
Report
Simulation sensors

Mesh quality
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Q) High

Jacobian points:

Mesher Settings

|| Remesh failed parts with incompatible mesh

Curvature based

Q) standard

[] Automatic transition

[ | Automatic trials for solids

Number of trials: 3 =
Factor for element size for each trial 08
Factor for tolerance for each trial 08

V| Automatic re-alignment for non-composite shells

Show advanced options for contact set definitions (No
' penetration and shrink fit anly)

Render beam profiles and shell thicknesses (slower)

Do not show mesh after meshing has completed.

I

oK ] { Cancel ] [ Help...

Mesh type: Standard

Figure 2-13: Mesh settings in the Options window.

Use this window to verify that the mesh quality is set to High and the mesh type
is set to Standard. Use these settings for other exercises unless indicated

otherwise.
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The difference between High and Draft mesh quality is:

O Draft quality mesh uses first order elements
0 High quality mesh uses second order elements

Differences between first and second order elements were discussed in chapter 1.

The difference between Curvature based mesh and Standard mesh will be
explained in chapter 3. Now, right-click the Mesh folder to display the pop-up
menu (Figure 2-14).

G tensile load 01 (-Default-)
@ HOLLOW PLATE (-Alloy Steel-)
3 Connections

* [B Fixtures

(¥ Fixed-1
~ 1l External Loads
Right-click 4 Force-1 (Per item: -100000 N:)
Mesh to display ___| @ Mesh

mesh pop up menu Resul @ Mesh Advisor...

85 Simplify Model for Meshing
@ Create Mesh.. —— Create Mesh

Mesh and Run

Failure Diagnostics...

@ Details...
Apply Mesh Control...
& Create Mesh Quality Plot...

f® List Selected

/ Probe

@ Show Mesh
Hide All Control Symbols
Show All Control Symbols

M@ Copy

Figure 2-14: Mesh pop-up menu.

Select Create Mesh from the pop-up menu.

In the pop-up menu, select Create Mesh. This opens the Mesh window (Figure
2-15) which offers a choice of element size and element size tolerance.
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This exercise reinforces the impact of mesh size on results. Therefore, we will
solve the same problem using three different meshes: coarse, medium (default),
and fine. Figure 2-15 shows the respective selection of meshing parameters to
create the three meshes.

Mesh @ Mesh @ Mesh @
v % e | Show FeatureManager
Mesh Density ~ Mesh Density Mesh Density
% ( & 0 B 0
Coarse Fine Coarse Fine Coarse Fine
7| Mesh Parameters A ¥ Mesh Parameters 7| Mesh Parameters

Q) Standard mesh

Curvature-based mesh A

@) Standard mesh

Curvature-based mesh

Q) Standard mesh

Curvature-based mesh

Blended curvature-based mesh J Blended curvature-based mesh Blended curvature-based mesh
E (om -] B [om - I -
& | 11.44906635mm P & | 572453318mm - A [ 2.86226659mm Y~
il RSARERNRRRERRERET |1 | [F RRRREREERER REETT T T T o =
A - S - A =
sk | 0.57245332mm b — +ie | 0.28622666mm vis sk | 0.14311333mm - I
- T = = ! saannl T REIEEE T ERETTIT
[] Automatic transition Automatic transition Automatic transition
Advanced v Advanced Advanced
Options - Options Options
Coarse Default Fine

Figure 2-15: Three choices for mesh density from left to right: coarse, medium

(default), and fine.

Show Mesh Parameters to see the element size. In all three cases use Standard
mesh. Notice the different slider positions in the three windows. Verify that

standard mesh is used.

The medium mesh density, shown in the middle window in Figure 2-15, is the
default that SOLIDWORKS Simulation proposes for meshing our model. The
element size of 5.72 mm and the element size tolerance of 0.286 mm are
established automatically based on the geometric features of the
SOLIDWORKS model. The 5.72 mm size is the characteristic element size in
the mesh, as explained in Figure 2-16. The default tolerance is 5% of the global
element size. If the distance between two nodes is smaller than this value, the
nodes are merged unless otherwise specified by contact conditions; contact
conditions are not present in this model.

Mesh density has a direct impact on the accuracy of results. The smaller the
elements, the lower the discretization error, but the meshing and solving time

both take longer. In the majority of analyses with SOLIDWORKS Simulation,
the default mesh settings produce meshes that provide acceptable discretization
errors, while keeping solution times reasonably short.
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Tetrahedral element Triangular element

Figure 2-16: Characteristic element size for a tetrahedral element (left) and
triangular element (right).

The characteristic element size of a tetrahedral element can be defined as the
diameter h of a circumscribed sphere (left). This is easier to illustrate with a 2D
analogy of a circle circumscribed on a triangle (vight).

Right-click the Mesh folder again and select Create... to open the Mesh
window. With the Mesh window open, set the slider all the way to the left (as
illustrated in Figure 2-15, left) to create a coarse mesh, and click the green
checkmark button. The mesh will be displayed as shown in Figure 2-17.

Figure 2-17: A coarse mesh created with second order, solid tetrahedral elements.

You can control the mesh visibility by selecting Hide Mesh or Show Mesh from
the pop-up menu shown in Figure 2-14.
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The presence of a mesh is reflected in the appearance of the solid folder and the
mesh folder in a Simulation study (Figure 2-18).

) HOLLOW PLATE §) HOLLOW PLATE

& Mesh @& Mesh

Before meshing After meshing

Figure 2-18: Solid folder and mesh folder in a Simulation study before and after
meshing.

After meshing, cross hatching is added to the Solid folder and cross-hatching
and a green check mark is added to the Mesh folder. Assigning material
properties adds a green check mark to the Solid folder, this check mark is not
shown here.

To start the solution, right-click the tensile load 01 study folder which displays a
pop-up menu (Figure 2-19). Select Run to start the solution.

C{* tensile load 01 (-De*--*+ N |

@ HOLLOW PLATE w Run ——— Run solution
@3 Connections | @ Update All Components
~ [ Fixtures &2 Export..
&

(€ Fixed-1 2
~ L} External Loads @ Trend Tracker

4 Force-1 (:Per db Create Submodeling Study
@& Mesh T8 Load Case Manager
Result Options | o Copy Study

& Shell Manager
@ Plot Imported Results...

IE Details...
Properties...
&B Mass Properties...

K Define Eunction Curves...

Figure 2-19: Pop-up menu for the tensile load 01 folder.

Start the solution by right-clicking the tensile load 01 folder to display a pop-up
menu. Select Run to start the solution.
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The solution can be executed with different properties, which we will investigate
in later chapters. You can monitor the solution progress while
the solution is running (Figure 2-20).

3 tensile load 01 lﬂ]_lg
Solving:

| 3= | 18.2%

Memory Usage:92,292K
Elapsed Time:3s

[¥] Always show solver status when you run analysis

[ Pause ] [ Cancel ] [ More > > ]

Figure 2-20: Solution Progress window.

The solver reports solution progress while the solution is running.

If the solution fails, the failure is reported as shown in Figure 2-21.

Simulation ﬁ Simulation ﬁ

8 No restraints are defined.
You may use Soft Spring or Inertia Relief options.

! , HOLLOW PLATE-tensile load 01: Failed

Search SOLIDWORKS Knowledge Base for more information
OK

Figure 2-21: Failed solution warning windows.

Here, the solution of a model with no restraints was attempted. Once the error

message has been acknowledged (left), the solver displays the final outcome of
the run (right).

When the solution completes successfully, Simulation creates a Results folder
with result plots which are defined in Simulation Default Options as shown in
Figure 2-5.
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In a typical configuration three plots are created automatically in the Static
study; make sure that the above plots are defined in Simulation options, if not,

define them:

o Stressl
e Displacementl

o  Strainl

showing von Mises stresses

showing resultant displacements

showing equivalent strain

Once the solution completes, you can add more plots to the Results folder. You
can also create subfolders in the Results folder to group plots (Figure 2-22).

C* tensile load 01 (-Default-)
w HOLLOW PLATE (-Alloy Steel-)
2 Connections
~ [ Fixtures
X Fixed-1
¥: Lﬂ External Loads
Jv_ Force-1 (:Per item: -100000 N:)
@ Mesh
Result Options
~ Results
& Streskl (-vonMises-)
@' Displacement] (-Res disp-)
& Strail (-Equivalent-)

Right-click Results Options
to display Results Option
window shown below

!

Result Options

v x

Message

Displacements and reactions are
always calculated. Not storing
stresses and strains, saves disk space

Quantities to save into file

[¥/] stresses and strains

Figure 2-22: More plots and folders can be added to the Results folder.

__f' Advisor...
Solver Messages...

®" Define Factor Of Safety Plot...
&u Define Stress Plot...

®' Define Displacement Plot...
@E Define Strain Plot...

; B} Define Design Insight Plot...

Gl,?" Define Fatigue Check Plot...
& Results Equations..

List Stress, Displacement, Strain

B List Result Force..

% Compare Results...
Create Body from Deformed Shape...
@, Save All Plots as JPEG Files

148 Save All Plots as eDrawings

= Create New Folder
@ Copy

N

You may define
and display
additional plots

Right-clicking on the Results folder activates this pop-up menu from which plots
may be added. Three plots are automatically created if Results Options include
these three plots: Stress, Displacement, Strain.
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The Result Options window shown in Figure 2-22 has different choices
depending on the type of study. In a Static study, deselecting Stress and strain
disables calculation of stress and strain which reduces calculation time and the
size of solution data base. This may be important in analysis of very large

models.

To display stress results, double-click on the Stress1 icon in the Results folder or
right-click it and select Show from the pop-up menu. The stress plot is shown in

Figure 2-23.
Default Options - Units u
Default Options
Units
Load/Fixture Unit system
Mesh @51 (MKS)
Results () english @ps)
& Plot ©) Metric (G)
Report
Units
Length/Displacement: @
Angular velocity:
Pressure/Stress: —_— MPa
ok | [ cancel | | mep. |

von Mises (N/mm»2 (MPa))

3399

3140
2881

. 2623

_ 2364

2105

1846

158.7

1328

107.0

811

55.2

293

— Yield strength: 620.4

Figure 2-23: Stress plot displayed using default stress plot settings.

Von Mises stress results are shown by default in the stress plot window. Notice
that results are shown in [MPa] as was set in the Default Options tab shown in
Figure 2-5 and repeated here in the top illustration. The highest stress 340 MPa
is below the material yield strength, 620 MPa. The actual numerical results may
differ slightly depending on the solver, software version, and service pack used.
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Once the stress plot is showing, right-click the stress plot icon to display the pop-
up menu featuring different plot display options (Figure 2-24).

@y Hide

@ Edit Definition..
P Animate...

@ Section Clipping...
& 150 Clipping...

% Mesh Sectioning...
ﬂu Chart Options...
T Settings...

/ Probe

£ List Selected

=% Deformed Result

@‘3 Compare Results...

@ Print...

Save As ...

5 Add to New Folder

@ Copy
X Delete...

S ER 4 €]

@ Stress plot @

v X ™

Definition ‘ Chart Optionsl Settings ‘

Display A

@ IVON: von Mises Stress "}

g [wmm~2 ovpa) -
Advanced Options v
Deformed shape v
Property he j

Edit Definition

Figure 2-24: Pop-up menu with plot display options.

S ER[®[E]

& Stress plot ®

v X =™

Definition | Chart Options | Settings

["] show min annotation
["] show max annotation
Show plot details

[#] show legend

Show Min/Max range on shown
parts only

& Automatically defined maximum
value

)
D 34354141235

7l Automatically defined minimum
value

A

28.67801285

Position/Format

Predefined positions

{u]jfu]j{x]
80

>

>

20 %

[Normal

o o

[scientific

§

3 -

Use different number format for
[ small numbers (0.001 < |x| <
1000)

Chart Options

Display Options ~

Color Options v

SELEG

& Stress plot @

v X -

Definition | Chart Options | Settings |

Fringe Options

’Continuous

Boundary Options

[Model

Deformed Plot Options

] Superimpose model on the
"~ deformed shape

Translucent (Part colors) .

parency

I»

0.8999939976

4

Settings

Plots can be modified using selections from the pop-up menu (top). Callouts
relate selections in the pop-up menu to the invoked windows. Color Options
selection in Chart Options is not shown. The same menus may by invoked by
right-clicking on the color legend of result plots.
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Explore all selections offered by these three windows shown in Figure 2-24. In
particular, explore scientific, floating and general format options in Chart
Options and color Options also in Chart Options. Notice that you may switch
between Definition, Chart Options and Settings cither by using the pop-up
menu shown in Figure 2-24 or by using tabs at the top of these windows.

Use Edit Definition to change units if necessary. Chart Options offers control
over the format of numerical results, such as scientific, floating, and general, and
also offers a different number of decimal places. Explore these choices. In this
book, results will be presented using different choices most suitable for the
desired plot. In many plots in this book Color Options will be User Defined to
replace dark blue color with grey color which shows better in print. Figure 2-24
shows the User Defined menu. Position of the color legend may be sometimes
modified for improved layout.

The default type of Fringe Options in the Settings window is Continuous
(Figure 2-24). Change this to Discrete through the Default Options window, by
selecting Plot (Figure 2-5). This way you won’t have to modify the future plots
individually. In this book we will be using Discrete Fringe Options to display
fringe plots. The plots from the current study will not change after changing the
default options.

Since the above change does not affect already existing plots, we now examine
how to modify the stress plot using the Settings window shown in Figure 2-25.
In Settings, select Discrete in Fringe options and Mesh in Boundary options
to produce the stress plot shown in Figure 2-25.

58



Engineering Analysis with SOLIDWORKS Simulation 2019

von Mises (N/mm~*2 [MPa))
339.9
314.0

288.1

Ara.a

Stress Component  *

8% Fringe Options »
@ Show Mesh

®} Edit Definition...
P Animate..

# Section Clipping...
@ Iso Clipping...

@ Mesh Sectioning...
Bo Chart Options..
T Settings...

f Probe

1% List Selected

=% Deformed Result

% Compare Results...

X Delete...

Figure 2-25: The modified stress plot is shown with discrete fringes and the mesh
superimposed on the stress plot (top). Numbers use floating format with one
decimal place. The plot also shows a shortcut menu that can be used to modify

display options.

Right-click the color bar to invoke the shortcut menu shown.

The stress plot in Figure 2-25 shows node values, also called averaged stresses.
Element values (or non-averaged stresses) can be displayed by proper selection
in the Stress Plot window in Advanced Options. Node values are most often
used to present stress results. See chapter 3 and the glossary of terms in chapter
23 for more information on node values and element values of stress results.

Before you proceed, investigate this stress plot with other selections available in
the windows shown in Figure 2-24.

We now review the displacement and strain results. All of these plots are created
and modified in the same way. Sample results are shown in Figure 2-26
(displacement) and Figure 2-27 (strain).
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URES (mrm)
0118
l 0.108
0.098

_ 0.088
0.079

0.069
0.059
0.049
0.039
0.029
0.020

. 0.010

— 0.000

' Displacement plot @

v X -

Definitionl Chart Options| Settingsl

Display A
G [UR.ES: Resultant Displacement ']
B [am 2
Advanced Options v
Deformed shape A
@) Automatic

08 |169.7489624

(7) True scale
(") user defined

0a |1

Show colors

Show colors selected

Displacement plot

2

v X -

Definition | Chart Options | Settings ‘

Display

G [URES: Resultant Displacement ']

Advanced Options
Deformed shape
(@) Automatic
0o | 169.7489624
() True scale
() User defined

Oa 1

[ ]show colors

Show colors deselected

Deformed shape plot

Figure 2-26: Displacement plot (left) and Deformation plot (right).

A Displacement plot can be turned into a Deformation plot by deselecting Show

Colors in the Displacement Plot window. The same window has the option of
showing the model with an exaggerated scale of deformation as shown above.
Both plots show the deformed shape; this option may also be deselected. The
blue color in the Displacement plot has been replaced with a gray color for
better appearance in this illustration. That was done in Chart Options, Color
Options, User defined.
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ESTRN
1.281e-003
1.185e-003

1.089e-003

. 9.929e-004
§.969e-004
8.009e-004
7.049e-004
6.089e-004
5.129e-004

4.169e-004

3.209e-004

2.249e-004

1.289e-004

Figure 2-27: Strain results.

Strain results are shown here using Element values. The mesh is also shown.

The plots in Figures 2-23, 2-25, 2-26, 2-27 all show the deformed shape in an
exaggerated scale. You can change the display from deformed to undeformed or
modify the scale of deformation in the Displacement Plot, Stress Plot, and
Strain Plot windows, activated by right-clicking the plot icon, then selecting
Edit Definition.

Now, construct a Factor of Safety plot using the menu shown in Figure 2-22.
The definition of the Factor of Safety plot requires three steps. Follow steps 1
through 3 using the selection shown in Figure 2-28. Refer to chapter 1 and
review Help to learn about failure criteria and their applicability to different
materials.

61



Engineering Analysis with SOLIDWORKS Simulation 2019

Review Message and Help
(question mark) to learn more
about failure criteria

- \

[& Factor of Safety @
v X ®
Message ~

For Ductile materials use Mgx von Mises stress
or Max Shear stress criterign.

For Brittle materials use Mohr-Coulomb stress
or Maximum Normal stress criterion.

Step 1of 3 ~

7]
]

(©) selected bodies
Advanced Options L‘fj

3? [Max von Mises Stress

O vonMises < 1
T Limie

Property ~
[include title text

[ Associate plot with name view
" orientation

*Front v

Average results across boundary for
parts

Step 1

Use von Mises Stress criterion.
Review Property options to
insert text and/or use specific
views for the plot.

Click right arrow to move
through windows

@ Factor of Safety

v x ® ®

Step 2 of 3 o
E {N/mm"z (MPa) V]

Set stress limit to
(@) Yield strength
_) Ultimate strength
User defined

1

Multiplication factor

1

Beam Results: )
Shell Results:

@ Minimum s

Material involved

Alloy Steel

Yield strength:

620.422 N/mm*2 (MPa)
Ultimate strength:
723.826 N/mm*2 (MPa)

Step 2
Select multiplication factor.

(& Factor of Safety @
v X @®
Step 3 of 3 A

Factor of safety distribution
(@) Areas below factor of safety
3
Safety result
Based on the maximum von Mises
stress criterion:

Minimum factor of safety:
1.80596

Step 3

Select “Areas below a factor
of safety” and enter the
number 3.

Figure 2-28: Three windows show the three steps in the Factor of Safety plot

definition. Select the Max von Mises Stress criterion in the first window.

To move through steps, click on the right and left arrows located at the top of the
Factor of Safety dialog.

Step 1 selects the failure criterion, Step 2 selects display units, sets the stress
limit and sets multiplication factor, Step 3 selects what will be displayed in the
plot. Here we select areas below the factor of safety 3.
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The factor of safety plot in Figure 2-29 shows the area where the factor of safety
is below the specified.

Figure 2-29: The red color displays the areas where the factor of safety falls
below 3. Irregular shape of these areas is caused by the coarse mesh used in this
study.

Mesh is shown.

We have completed the analysis with a coarse mesh and now wish to see how a
change in mesh density will affect the results. Therefore, we will repeat the
analysis two more times using medium and fine density meshes respectively. We
will use the settings shown in Figure 2-15. All three meshes used in this exercise
(coarse, medium, and fine) are shown in Figure 2-30.

Figure 2-30: Coarse, medium, and fine meshes.

Three meshes used to study the effects of element size on results.
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To compare the results produced by different meshes, we need more information
than is available in the plots. Along with the maximum displacement and the
maximum von Mises stress, for each study we

need to know:

e The number of nodes in the mesh.
e The number of elements in the mesh.
e The number of degrees of freedom in the model.
The information on the number of nodes and number of elements can be found in

Mesh Details accessible from the menu in Figure 2-14. The mesh Details
window is shown in Figure 2-31.

Study name tensile load 01 (-Default-)
Mesh type Solid Mesh
Mesher Used Standard mesh
Automatic Transition Off

Include Mesh Auto Loops Off

Jacobian points 4 points
Element size 11.4491 mm
Tolerance 0.572453 mm
Mesh quality High

Total nodes 2768

Total elements (1472

Maximum Aspect Ratio 6.5595
Pgrcentage of e_lements 99.9

with Aspect Ratio < 3

Percentage of elements 0

with Aspect Ratio > 10

% of distorted elements 0

(Jacobian)

Time to complete mesh(hh:mm:ss) | 00:00:00
Computer name

Figure 2-31: Mesh details window.

Right-click the Mesh folder and select Details from the pop-up menu to display
the Mesh Details window. Notice that information on the number of degrees of
freedom is not available here.
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Another way to find the number of nodes and elements and also the number of
degrees of freedom is to use the pop-up menu shown in Figure 2-32. Right-click
the Results folder and select Solver Messages to display the window shown in
Figure 2-32.

i | Solver Message ﬁ

No. of nodes 2768
No. of elements 1472
No. of DOF 8133
Total solution time 00:00:01

OK Save

Figure 2-32: The Solver Message window lists information pertaining to the
solved study.

Click the Save button to save this solver message.

Now create and run two more studies: tensile load 02 with the default element
size (medium), and tensile load 03 with a fine element size, as shown in Figure
2-15 and Figure 2-30. To create a new study, we could just repeat the same steps
as before but an easier way is to copy the original study. To copy a study, follow
the steps in Figure 2-33.
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Copy Study T o
v X w
@¥ tensile load 01 (-Default-)
@ HOLLOW PLATE (-Alloy Steel-) F— v
§1 Connections
~ [ Fixtures Source Study ~
Qe Fixed-1 it [tensile load 01 ']
i L& External Loads Study name:
b 4 Force-1 (Peritem: -100000N) | (9 i it L g) .
Mesh nter new stu
Select Copy Stud TR : y
Result Options Py Yy Configuration to use: name
~ [ Results [Defauit v]

[ Stressl (-vonMises-) | ‘ Faroct Stud .
al u
@' Displacement] (-Res disp-) Copy Study 9 Y | @
Rename Static

c : .
& Strainl (-Equivalent-) Sewd Select Static
o= ‘ Nonlinear
Create New Motion Study —

Create New Simulation Study Eu‘ Linear Dynarmic

| Create New Design Study
[0 10 Model | Motion Study I | * tensile load 01

E‘ Topology Study

Q)
Right-click study tab tensile load 01

Figure 2-33: A study can be copied into another study in three steps as shown.

Notice that all definitions in a study (material, restraints, loads, mesh) can also
be copied individually from one study to another by dragging and dropping them
into a different study tab.

A study is copied complete with results and plot definitions. Before remeshing
with default element size, you must acknowledge the warning message shown in
Figure 2-34.

Simulation ﬂ

!‘ . Remeshing will delete the results for study: tensile load 02.
\

— )

D Do not show again [ OK ] [ Cancel

0 You can restore the suppressed messages from Simulation Options
> System options > Messages/Errors/Warnings.

Figure 2-34: Remeshing deletes any existing results in the study.
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The summary of results produced by the three studies is shown in Figure 2-35.

Element size Number of Number of Number of Max: result Max. von
Study displ. Mises stress
[mm] nodes elements DOF
[mm] [MPa]
tensile load 01 11.45 2768 1472 8133 0.117863 339.9
tensile load 02 5.72 12222 7040 36111 0.118068 369.8
tensile load 03 2.86 84112 54969 250851 0.118074 377.1

Figure 2-35: Summary of results produced by the three meshes.

Notice that these results are based on the same problem. Differences in the
results arise from the different mesh densities used in studies tensile load 01,
tensile load 02, and tensile load 03.

The actual numbers in this table may vary slightly depending on the type of

solver and release of the software used for solution.

Figure 2-36 shows the maximum resultant displacement and the maximum von
Mises stress as a function of the number of degrees of freedom. The number of
degrees of freedom is in turn a function of mesh density.
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0.1181 4

0.1181 /.

0.1180 ///
0.1180 / Max. resultant displacement

0.1179
0.1179 -
0.1178 T T 1
1000 10000 100000 1000000 # DOF
m -
375 //.
370 /
385 /
360 .
/ Max. von Mises stress

355 /
350 /
345 d
340 T r 1

1000 10000 100000 1000000 # DOF

Figure 2-36: Maximum resultant displacement (top) and maximum von Mises

stress (bottom).

Both are plotted as a function of the number of degrees of freedom in the model.
The three points on the curves correspond to the three models solved. Straight
lines connect the three points only to visually enhance the graphs.

Having noticed that the maximum displacement increases with mesh refinement,
we can conclude that the model becomes “softer” when smaller elements are
used. With mesh refinement, a larger number of elements allows for better
approximation of the real displacement and stress field. Therefore, we can say
that the artificial restraints imposed by element definition become less imposing
with mesh refinement.

Displacements are the primary unknowns in structural FEA, and stresses are
calculated based on displacement results. Therefore, stresses also increase with
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mesh refinement. If we continued with mesh refinement, we would see that both
the displacement and stress results converge to a finite value which is the
solution of the mathematical model. Differences between the solution of the FEA
model and the mathematical model are due to discretization errors, which
diminish with mesh refinement.

We will now repeat our analysis of the HOLLOW PLATE by using prescribed
displacements in place of a load. Rather than loading it with a 100000N force
that caused a 0.118 mm displacement of the loaded face, we will apply a
prescribed displacement of 0.118 mm to this face to see what stresses this causes.
For this exercise, we will use only one mesh with the default (medium) mesh
density.

Define a fourth study, called prescribed displ. The easiest way to do this

is to copy one of the already completed studies, for example study tensile load
02. The definition of material properties, the fixed restraint to the left-side end-
face and mesh are all identical to the previous design study. We need to delete
the current External Loads (right-click the load icon and select Delete) and
apply in its place a prescribed displacement.

To apply the prescribed displacement to the right-side end-face, right-click the
Fixtures folder and select Advanced Fixtures from the pop-up menu. This
opens the Fixture definition window. Select On Flat Face from the Advanced
menu and define the displacement as shown in Figure 2-37. Check Reverse
direction to obtain displacement in the tensile direction. Notice that the direction
of a prescribed displacement is indicated by a restraint symbol.

Prescribed displacement may also be defined from the External Loads folder by
selecting Prescribed Displacement from the pop-up menu. This opens the same
Fixture definition window. Figure 2-37 illustrates both methods of defining
prescribed displacement.
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{1 Foundation Bolt...

Advanced Fixtures...
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Show All

@ Copy

Method 1
Using Fixture

Previously
defined Fixed —

restraint

i é‘s‘ prescribed displ (-Default-)
& HOLLOW PLATE (-Alloy Steel-)
g3 Connections

» [ Fixtures
18 Extern~! | ~nde
& Mesh & Advisor

Result 4 Force...

¥ 4\ Re & Torque...
L Pressure...
o Gravity...
=5 Centrifugal...
B Bearing Load...
4 Temperature..

Iﬂi Prescribed Displacement... 4

A% Flow Effects...
Thermal Effects...

é Remote Load/Mass...
§ Distributed Mass..

5 Create New Folder

Hide All
Show All

@ Copy

Method 2
Using External Loads
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Figure 2-37: Two methods of defining prescribed displacement.

Prescribed
—— displacement

in the direction

normal to face

The prescribed displacement of 0.118 mm is applied to the same face where the
tensile load of 100000N was applied in previous studies.

Verify that the arrows (shown in black color) are pointed away from the selected

face.
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Once again, notice that the visibility of all loads and restraints symbols is
controlled by right-clicking the symbol and making the desired choice
(Hide/Show). All load symbols and all restraint (fixture) symbols may also be
turned on/off all at once by right-clicking the Fixtures or External loads folders
and selecting Hide all/ Show all from the pop-up menu.

Once a prescribed displacement is defined to the end face, it overrides any
previously applied loads to the same end face. While it is better to delete the load
in order to keep the model clean, a load has no effect if a prescribed
displacement is applied to the same entity in the same direction.

Figure 2-38 compares stress results for the model loaded with force to the model
loaded with prescribed displacement.
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Figure 2-38: Comparison of von Mises stress results.

Von Mises stress results with a load applied as a force (top) and von Mises stress
results with a load applied as a prescribed displacement (bottom).
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Results produced by applying a force load and by applying a prescribed
displacement load are very similar but not identical. The reason for this
discrepancy is that in the model loaded by force, the loaded face does not remain
flat. In the prescribed displacement model, this face remains flat, even though it
experiences displacement as a whole. Also, while the prescribed displacement of
0.118 mm applies to the entire face in the prescribed displacement model, it is
only seen as a maximum displacement in one point in the force load model. You
may plot the displacement along the edge of the end face in study tensile load 02
by following the steps in Figure 2-39.
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Figure 2-39: Plotting displacement along the edge of the force loaded face in
study tensile load (2.

Right click the resultant displacement plot in the tensile load 02 study to invoke a
pop-up menu shown in the top left corner. Follow steps 1 through 4 to produce a
graph of displacements along the loaded edge. Repeat this exercise for a model
loaded with a prescribed displacement to verify that the displacement is constant
along the edge.
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We conclude the analysis of the HOLLOW PLATE by examining the reaction
forces using the results of study tensile load (2. In the study tensile load 02,
right-click the Results folder. From the pop-up menu, select List Result Force to
open the Result Force window. Select the face where the fixed restraint is
applied and click the Update button. Information on reaction forces will be

displayed as shown in Figure 2-40.
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Figure 2-40: Result Force window.

(3)
Select
Reaction force

If desired, reference
geometry can be
selected to define
directions of reaction
components

“

Click Update

(5)

Review reaction
forces in the Result
Force window and in
the model display

If Display resultant
forces is selected then
one resultant force is
displayed. Otherwise
reaction components
are displayed as shown
here.

Right-click the Results folder and follow steps 1 through 4 to analyze and display
reaction forces. Reaction forces can also be displayed in components other than

those defined by the global reference system. To do this, reference geometry such
as a plane or axis must be selected.
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A note on where Simulation results are stored: By default, all study files are
saved in the same folder with the SOLIDWORKS part or assembly model.
Mesh data and results of each study are stored separately in *.CWR files. For
example, the mesh and results of study tensile load 02 have been stored in the
file: HOLLOW PLATE-tensile load 02.CWR

When the study is opened, the CWR file is extracted into a number of different
files depending on the type of study. Upon exiting SOLIDWORKS Simulation
(which is done by means of deselecting SOLIDWORKS Simulation from the
list of add-ins, or by closing the SOLIDWORKS model), all files are
compressed allowing for convenient backup of SOLIDWORKS Simulation
results.

The location of CWR files is specified in the Default Options window (Figure
2-5). For easy reference, the Default Options window is shown again in Figure
2-41.

The size of the CWR file may be significantly reduced if stresses and strains are
deselected in the Results Options (Figure 2-22). We will work with simple
models; therefore, we won’t use this option.
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Default Options

Default Options - Results u
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Mesh T
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Figure 2-41: Location of solution database files.

You may use the SOLIDWORKS document folder or a user defined folder as
shown above.

Using the settings shown in Figure 2-41, the solution data base files are located
in folder F:\FEA results. The default location is the SOLIDWORKS document
folder.
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Models in this chapter
Model Configuration | Study Name Study Type
tensile load 01 Static
HOLLOW PLATE.sldprt Default tensile load 02 Static
tensile load 03 Static
prescribed displ Static
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